# Contents

## About this publication
- Who should use this publication. ........................................ v
- How to use this publication ........................................ v
  - About operating environments ................................. vi
  - Before you begin working with OnDemand ................... vi
- Where to find more information ................................ vi
  - Accessibility information for OnDemand ................. vii
  - Support available on the Web ............................... viii
- How to send your comments ...................................... viii
- Summary of changes .............................................. ix

## Chapter 1. Overview
- Content Manager OnDemand ..................................... 1
- The OnDemand system ........................................... 1
- OnDemand documents ............................................ 2
- OnDemand folders ............................................... 2
- Getting help .................................................... 3
  - Getting task help ........................................... 3
  - Getting help for Windows ................................. 3
  - Getting help for menu commands ...................... 3
  - Using the help index .................................. 3

## Chapter 2. Requirements
- Hardware ....................................................... 5
- Software ..................................................... 5
  - Adobe software .......................................... 5
  - Memory .................................................... 6
  - Disk space ............................................... 6

## Chapter 3. Installing the client on Windows
- Obtaining OnDemand client software .......................... 7
- Installing the client on Windows ............................. 7
  - Installing the client on a user’s PC ....................... 7
  - To install on a network file server ..................... 8
  - Running automated installation .......................... 8
  - Installing user-defined files ............................. 8
  - Mapping AFP fonts ....................................... 8

## Chapter 4. Updating client software

## Chapter 5. Configuring OnDemand Version 7.1 client to access an OnDemand for OS/390 Version 2.1 server
- Step 1: Recommended: Configuring the client to run in short sockets mode .................................. 11
- Step 2: Required: Adding the required command line parameters ......................................... 11
- Step 3: Required for OLE: Using the SetFolderCloseMemoryRelease method .......................... 12
- Step 4: Recommended: Configuring the client to run in short sockets mode ............................ 12
- Step 5: Clearing the Attempt Unified Logon check box in the Update Servers window to access an OS/390 server .......................................................... 13

## Chapter 6. Starting the OnDemand client
- Optional: Specifying startup parameters................... 15
  - Specifying parameters .................................. 16
- Starting from the desktop ................................... 16
- Starting from the Start menu ................................ 17
- Starting from the Run command window .................... 17

## Chapter 7. Logging on to a server

## Chapter 8. Updating server information
- Updating information for TCP/IP servers .................. 21
  - Adding a TCP/IP server .................................. 21
  - Changing a TCP/IP server ............................... 22
- Updating information for local servers ..................... 22
  - Adding a CD-ROM server ................................ 23
  - Adding a network or hard drive server ................. 24
  - Changing a local server ................................ 24
- Deleting a server ............................................ 24

## Chapter 9. Opening folders

## Chapter 10. Searching for documents
- Overview ......................................................... 29
- Searching for documents .................................... 30

## Chapter 11. Working with documents
- Overview ........................................................ 33
- Selecting documents for viewing ............................ 33
  - Working with more than one document ................. 34
- Viewing documents .......................................... 35
  - Moving to pages in a document ............................ 36
  - Finding information in a document .................... 37
  - Adding notes to a document ............................. 37
  - Printing and faxing documents ......................... 38
    - Printing from a document ............................ 38
    - Printing from the Document List ................... 39
  - Sending documents ...................................... 39
    - Sending from the Document List .................... 40
  - Viewing document properties ............................ 40

## Chapter 12. Using the CD-ROM as an OnDemand server

## Chapter 13. Ending your OnDemand session
- Closing documents .......................................... 45
About this publication

Welcome to the IBM® DB2® Content Manager OnDemand (OnDemand) client. You can use the client to access OnDemand servers and search, retrieve, view, and print documents1 (and much more).

This publication explains how to get started with the OnDemand client, use the client to search for documents, and do other basic tasks with documents.

This publication covers OnDemand client programs that run on Windows® 2000, Windows XP, or Windows Server 2003. All of the client programs enable you to complete the following basic tasks:

- To log on to a client
- To open folders
- To search for documents
- To retrieve documents
- To view documents
- To print documents

On all Windows platforms, you complete the basic tasks the same way. For example, opening a folder with the Windows 2000 client works the same way with the Windows XP client. There may be minor differences in how the client programs look. The look of the client programs on your system may be slightly different.

Important: The term *Windows client* refers to the OnDemand client program that runs on Windows 2000, Windows XP, and Windows Server 2003. The term *OnDemand server* refers to systems that are running the OnDemand for the following platforms:

- OnDemand for Multiplatforms Version 8.3
- OnDemand for z/OS® and OS/390® Version 7.1
- OnDemand for OS/390 Version 2.1

Who should use this publication

This publication is of primary interest to people who use OnDemand to search for, retrieve, and view documents. This publication introduces you to the basic features of the OnDemand client. For more information about the tasks that are described in this publication, please see the online Help when using the client. The online Help also contains details about the other things you can do with the client.

How to use this publication

This *User’s Guide* introduces you to the basic features of the OnDemand client. To use the client, your path control (PC) must communicate with an OnDemand server over a network. Please see your OnDemand administrator for information about the server that contains the documents that you need. Your OnDemand...
administrator can also verify that you have the correct operating environment and other information needed to use OnDemand.

**About operating environments**

This publication covers the Windows client.

To gain the full benefits of OnDemand, first familiarize yourself with the system that you plan to use. This publication assumes that you are familiar with the system environment and uses terminology specific to these systems. For help with your system, refer to your system documentation and the online Help.

**Before you begin working with OnDemand**

Before you start the client and begin to work with documents, we recommend the following:

- Familiarize yourself with your system and using a pointing device.
- Familiarize yourself with the OnDemand work space. When you start OnDemand, the main window appears. The main window is where you open folders, search for documents, and work with documents.
- See “Glossary” on page 57 for a list of terms that you will encounter when using OnDemand.
- Install the OnDemand client program. For more information about hardware and software requirements and installing the client, see Chapter 2, “Requirements,” on page 5.
- Find the name of your OnDemand server and your OnDemand userid and password.
- Find the name of the folder that contains the documents you need.
- Determine the best way to start the OnDemand program. For more information, see Chapter 6, “Starting the OnDemand client,” on page 15.

**How this publication is organized**

This book contains the following sections:

- Chapter 2, “Requirements,” on page 5 describes the hardware, software, memory, and disk space requirements for the OnDemand client and how to install the client.
- “Optional: Specifying startup parameters” on page 15 lists parameters that you can specify when you start the client.
- Chapter 8, “Updating server information,” on page 21 shows how to identify servers to the client.

**Where to find more information**

Your product package includes a complete set of information to help you plan for, install, administer, and use your system. All product documentation is provided in portable document format (PDF). You can view the PDF files online using the Adobe Acrobat Reader for your operating system. If you do not have the Acrobat Reader installed, you can download it from the Adobe Web site at www.adobe.com.

The following tables list the OnDemand publications for each platform.

Table 1. IBM DB2 Content Manager OnDemand for z/OS and OS/390, Version 7 publications

<table>
<thead>
<tr>
<th>Title</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Guide</td>
<td>SC27-1374</td>
</tr>
<tr>
<td>Configuration Guide</td>
<td>GC27-1373</td>
</tr>
<tr>
<td>Indexing Reference</td>
<td>SC27-1375</td>
</tr>
<tr>
<td>Introduction and Planning Guide</td>
<td>GC27-1438</td>
</tr>
<tr>
<td>Messages and Codes</td>
<td>SC27-1379</td>
</tr>
<tr>
<td>Migration Guide</td>
<td>LY37-3746</td>
</tr>
<tr>
<td>OnDemand Distribution Facility Installation and Reference Guide</td>
<td>SC27-1377</td>
</tr>
<tr>
<td>User’s Guide</td>
<td>SC27-0836</td>
</tr>
<tr>
<td>Web Enablement Kit Implementation Guide</td>
<td>SC27-1376</td>
</tr>
<tr>
<td>Windows Client Customization Guide and Reference</td>
<td>SC27-0837</td>
</tr>
</tbody>
</table>

Note: The IBM DB2 Content Manager OnDemand for z/OS: Migration Guide, is a licensed publication. It is available only for customers who are migrating from OnDemand for OS/390 Version 2.1 to OnDemand for z/OS and OS/390, Version 7.1. See your local IBM representative to obtain this publication.

The IBM DB2 Content Manager OnDemand for z/OS: Introduction and Planning Guide contains a glossary of terms for the OnDemand library. The IBM DB2 Content Manager OnDemand: User’s Guide has a smaller glossary selected for OnDemand users rather than administrators. The IBM DB2 Content Manager OnDemand for z/OS: OnDemand Distribution Facility Installation and Reference Guide includes a glossary of terms that are specific to the OnDemand Distribution Facility.

Table 2. IBM DB2 Content Manager OnDemand for Multiplatforms, Version 8.3 publications

<table>
<thead>
<tr>
<th>Title</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Guide</td>
<td>SC18-9237</td>
</tr>
<tr>
<td>Indexing Reference</td>
<td>SC18-9235</td>
</tr>
<tr>
<td>Installation and Configuration Guide</td>
<td>SC18-9232</td>
</tr>
<tr>
<td>Introduction and Planning Guide</td>
<td>GC18-9236</td>
</tr>
<tr>
<td>Messages and Codes</td>
<td>SC27-1379</td>
</tr>
<tr>
<td>Report Distribution: Installation, Use, and Reference</td>
<td>SC18-9233</td>
</tr>
<tr>
<td>User’s Guide</td>
<td>SC27-0836</td>
</tr>
<tr>
<td>Web Enablement Kit Implementation Guide</td>
<td>SC18-9231</td>
</tr>
<tr>
<td>Windows Client Customization Guide and Reference</td>
<td>SC27-0837</td>
</tr>
</tbody>
</table>

includes a glossary of terms that are specific to the OnDemand Report Distribution feature.

Table 3. IBM DB2 Content Manager OnDemand for iSeries™ Common Server, Version 5 publications

<table>
<thead>
<tr>
<th>Title</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Guide</td>
<td>SC41-5325</td>
</tr>
<tr>
<td>Common Server Administration Guide</td>
<td>SC27-1161</td>
</tr>
<tr>
<td>Common Server Indexing Reference</td>
<td>SC27-1160</td>
</tr>
<tr>
<td>Common Server Planning and Installation Guide</td>
<td>SC27-1158</td>
</tr>
<tr>
<td>Common Server Web Enablement Kit Installation and Configuration Guide</td>
<td>SC27-1163</td>
</tr>
<tr>
<td>Installation Guide</td>
<td>SC41-5333</td>
</tr>
<tr>
<td>Messages and Codes</td>
<td>SC27-1379</td>
</tr>
<tr>
<td>User's Guide</td>
<td>SC27-0836</td>
</tr>
<tr>
<td>Windows Client Customization Guide and Reference</td>
<td>SC27-0837</td>
</tr>
</tbody>
</table>

Accessibility information for OnDemand

For complete information about accessibility features that are supported by this product, see your OnDemand Administration Guide.

Support available on the Web

IBM provides updated product information online. Follow the Support link at one of these platform-specific Web sites for frequently asked questions, hints and tips, and technical notes.

- iSeries: http://www.ibm.com/software/data/ondemand/400/

Education and training

IBM offers several classes for OnDemand administrators. Follow the Training and certification link at at one of these platform-specific Web sites for course descriptions and prices.

- iSeries: http://www.ibm.com/software/data/ondemand/400/

How to send your comments

Your feedback helps IBM to provide quality information. Please send any comments that you have about this publication or other OnDemand documentation. Visit the IBM Data Management Online Reader’s Comment Form (RCF) page at: www.ibm.com/software/data/rcf.

Be sure to include the name of the product, the version number of the product, and the name of the book. If you are commenting on specific text, please include the location of the text (for example, a chapter and section title, a table number, a page number, or a help topic title).
Summary of changes

This edition of IBM DB2 Content Manager OnDemand User’s Guide, SC27-0836-04 contains new technical information and editorial changes. There may be some instances where changes were made, but change bars are missing. Significant changes to note from SC27-0836-03 include:

- Added four troubleshooting scenarios from support tech notes that are posted at www.ibm.com
- Added information about using the CD-ROM as an OnDemand server. See Chapter 12, “Using the CD-ROM as an OnDemand server,” on page 43
- Added information about filtering folder list (see Chapter 9, “Opening folders,” on page 27)
- Added information about popup tooltip for search criteria names in Chapter 10, “Searching for documents,” on page 29
- Added information about viewing document properties (see “Viewing document properties” on page 40)
Chapter 1. Overview

Content Manager OnDemand

Welcome to OnDemand – a system that is designed to help you control information. OnDemand manages electronic archives of documents, searches for documents, and retrieves documents. You can use the OnDemand client programs to view documents, send, fax, print copies of documents, and attach electronic notes to documents.

OnDemand supports any process and organization that can benefit from hard copy or microfiche replacement and instant access to information. An OnDemand system can support small office environments as well as large enterprise installations with hundreds of system users. OnDemand can dramatically improve productivity and customer service in most businesses by providing fast access to the information that is stored in the system.

OnDemand processes the print output of application programs, extracts index fields from the data, stores the index information in a relational database, and stores one or more copies of the data in the system. One example of the relational database where OnDemand stores the index information is IBM DB2 Universal Database™ (DB2). With OnDemand, you can archive newly created and frequently accessed documents on high speed, disk storage volumes. You can also automatically migrate documents to other types of storage volumes as they age.

OnDemand provides the following features:

- It fully integrates the capabilities of Advanced Function Presentation™ (AFP™), including management of resources, indexes, and annotations.
- It supports full fidelity reprinting and faxing of documents on devices that are attached to a PC, OnDemand server, or other server on the network.
- It integrates data that is created by application programs into an online, electronic information archive and retrieval system.
- It provides the controlled and reliable access to all of an organization’s reports.
- It retrieves the data that you need when you need it.
- It provides a standard, intuitive client with features such as thumbnails, bookmarks, notes, and shortcuts.

If you are an administrator, you can use OnDemand to complete the following tasks:

- To manage OnDemand servers
- To authorize users to access OnDemand servers and data stored in the system
- To back up the database and data storage

These features mean that OnDemand can help you quickly retrieve the specific page of a report that you need to provide fast customer service.

Some of the advantages that OnDemand offers over data archiving and retrieval systems that you may have used include the ability to:

- Retrieve the pages of the report that you need without processing the entire report.
• Easily locate data without specifying the exact report
• View selected data from within a report

OnDemand provides you with an information management tool that can increase your effectiveness when working with customers.

The OnDemand system

An OnDemand system consists of the following components:
• Client programs and server programs that communicate over a network
• A central database and the database manager program
• A storage manager that provides support for various types of storage devices to hold the reports that are stored in the system

The client program is your way to access documents that are stored in OnDemand. From the client program, you can complete the following tasks:
• Constructing queries and search for documents
• Retrieving items from OnDemand
• Viewing, printing, and faxing copies of documents
• Attaching electronic notes to documents

OnDemand servers manage control information and index data; store and retrieve reports, resources, and documents; and process query requests from OnDemand client programs. The OnDemand server manages a database of information about the users of the system and the reports that are stored in the system. The OnDemand server maintains documents that are on disk, optical, and tape storage devices. OnDemand servers may reside on different physical systems.

When you search for documents, the OnDemand client sends a search request to the OnDemand server. The server returns the list of documents that meet the search request. When you select a document for viewing, the client retrieves a copy of the document from the server on which the document is stored, opens a viewing window, and opens the document.

OnDemand documents

OnDemand documents represent indexed groups of pages. Typically an OnDemand document is a logical section of a larger report, such as an individual customer statement within a report that contains thousands of statements. An OnDemand document can also be a part of a larger report. For reports that do not have logical groups of pages, such as transaction logs, OnDemand can divide the report into groups of pages. The groups of pages are individually indexed, and the client can retrieve the groups of pages much more efficiently than it can retrieve the entire report.

OnDemand folders

Your OnDemand administrator stores information in related collections that are called folders. Think of a folder as a container for related information, such as statements, invoices, or correspondence, just like a manila folder is used in a metal filing cabinet. When you open a folder, you have access to the information contained in that folder. For example, a billing folder could contain the reports for customer transactions over the past two years. Folders are identified by name, for example, Customer Statements.
Getting help

Getting task help
Online Help for all OnDemand tasks is organized by task. The procedures give you quick, step-by-step directions to help you complete your tasks. To get task Help, select How Do I from the Help menu.

Getting help for Windows
Online Help is available for all OnDemand windows and windows. Window Help gives you detailed information about the purpose of the window and the fields, options, and commands that are contained in the window. To get window Help, click the Help button when the window is active.

Getting help for menu commands
Online Help is available for all of the commands on the OnDemand menus. Command Help gives you a brief description of the command. To get command Help, first select the command and then press the F1 key.

Using the help index
When you click the Index tab on OnDemand’s online Help, a list of keywords appears. Enter a word or subject and, if the word is on the list, the index scrolls to that keyword. When you double-click the keyword, Help either opens a Help topic or lists a set of topics from which to choose.
Chapter 2. Requirements

This section describes the hardware, software, memory, and disk space requirements for installing and using the OnDemand client.

Hardware

The OnDemand client requires the following hardware:

- An Intel™ Pentium® II 350 MHz or faster processor
- 64 MB of RAM and an additional 8 MB of RAM to view PDF documents
- Sufficient temporary space for documents being viewed and printed
- 100 MB of free hard disk space
- A super-VGA display and adapter with a minimum resolution of 800x600
- Physical connection to the network, such as a Token Ring or Ethernet network adapter
- **If you plan to install the OnDemand client from a network file server:** A CD-ROM drive for installation

Software

To install and use the OnDemand client, you must install and run Windows 2000, Windows XP, or Windows 2003 on the PC. To install the OnDemand client from a CD-ROM, you must install the CD-ROM drivers on the PC. To install the OnDemand client from a network file server, you must run the appropriate network software on the PC. To connect to an OnDemand server, you must run the standard Transmission Control Protocol/Internet Protocol (TCP/IP) support for Windows 2000, Windows XP, or Windows Server 2003 on the PC.

Adobe software

To view documents that require Adobe Type 1 Fonts, you must install and run Adobe Type Manager (ATM) on the PC. On Windows 2000 systems, ATM is part of the base operating system. If you plan to use some other operating system, IBM recommends that you obtain the ATM software from Adobe. You should install ATM **before** you install the OnDemand client software on the PC.

To view Adobe Portable Document Format (PDF) documents that are stored in OnDemand, you need the Adobe Acrobat PDF viewing software. IBM recommends that you use Adobe Acrobat to view PDF documents from the Windows client. You must purchase Adobe Acrobat from Adobe. You should install the Adobe Acrobat PDF viewing software **before** you install the OnDemand client software on the PC.

**Important:** OnDemand provides the ARSPDF32.API file to enable PDF viewing from the client. If you install the client after you install Adobe Acrobat, the installation program copies the API file to the Acrobat plug-in directory. If you install the client before you install Adobe Acrobat, you must copy the API file to the Acrobat plug-in directory. Also, if you upgrade to a new version of Acrobat, you must copy the API file to the new Acrobat plug-in directory. The default location of the API file is `\Program Files\IBM\OnDemand32\PDF`. The default Acrobat plug-in directory is `\Program Files\Adobe\Acrobat x.y\Acrobat\Plug_ins`, where `x.y` is the version of Acrobat, for example, 4.0, 5.0, and so forth.
Memory

The OnDemand client requires at least 64 MB of memory. The PC may need more memory if you plan to work with more than one document at a time. The PC may also need more memory if you run more than one program at the same time.

Disk space

To install the OnDemand client, disk space requirements depend on the features that you select.

You need at least 55 MB of available disk space to install all of the OnDemand features. To use less than 55 MB of disk space, use the Installation Components and Subcomponents option in Setup to select only the features you need.

You should also plan to allot space for temporary files. IBM recommends that you have 50 MB of available disk space for temporary files.

For more information on disk space requirements for each OnDemand feature, start Setup from the CD-ROM, or follow the Setup steps below:

1. Insert the CD-ROM in the appropriate drive.
2. From the Windows taskbar, click Start, and then choose Run.
3. Type x:\client\windows\win32\setup (where x is the letter of your CD-ROM drive).
5. On the Installation Components and Subcomponents window you can select each component individually and then click Change to see all the specific features and their disk space requirements.
Chapter 3. Installing the client on Windows

Obtaining OnDemand client software

Important: If the Clients CD-ROM that you receive with your product package contains OnDemand client software that is earlier than version 7.1.0.4, you should not use the CD-ROM. Instead, you should get the latest OnDemand client installation file from IBM service on the Web at http://service.software.ibm.com/software/ondemand/fixes. See Chapter 4, “Updating client software,” on page 9 for instructions on downloading the client installation file from the Web.

Installing the client on Windows

When you install OnDemand by using the CD-ROM, you can use the traditional installation method.

You can install all of the OnDemand features at once, or individual features as you need them.

Installing the client on a user’s PC

To install from the CD-ROM or to install from a network file server, follow these instructions:

1. Insert the CD-ROM in the appropriate drive, or obtain the drive letter of the network drive that holds the OnDemand client software.
2. From the Windows taskbar, click Start, and then choose Run.
3. Type
   
   x:\client\windows\win32\setup

   (where x is the letter of your CD-ROM drive or the network drive).
4. Click OK.
5. After the Setup program starts, click Next to continue. The Setup program transfers the OnDemand client files from the CD-ROM to your PC.
6. On the Setup Type and Working Directory window, choose the type of installation:
   - Select Typical to install a copy of the OnDemand client to the hard disk on the user’s PC. The Setup program runs a Typical install by default unless you select the Compact or Custom option.
   - Select Compact to configure the PC to run a copy of the OnDemand client from a shared location on a network file server or from the product CD-ROM. After selecting Compact, you must identify the full path of where the OnDemand client program files reside on the network file server (or product CD-ROM).
   - Select Custom to choose the components to install on the PC. You must select Custom:
     - To install the administrative client on a PC
     - To install the OnDemand client in a language other than the default language that is set on the PC
     - To install the Sonoran fonts on the PC
7. The Destination Folder shows the installation drive and directory. Click **Browse** to install the files to a different hard disk or directory.

8. Follow the instructions on the screen to complete the installation.

**To install on a network file server**

OnDemand also supports **distribution** and **multiple user installs**:

- Use a distribution install to copy the OnDemand client software from the CD-ROM to a shared location on a network file server. After copying the software to the server, other users can run subsequent standard, node, and custom installs from the server.

- Use a multiple user installation to install an OnDemand client to a shared location on a network file server. After installing the client on the server, other users can run subsequent Typical and Custom installs from the server.

For more information about distribution and multiple user installations, see the *IBM DB2 Content Manager OnDemand: Windows Client Customization Guide*.

**Running automated installation**

Automated installation allows administrators to standardize the OnDemand installation for all users in an organization. It also allows administrators to install OnDemand clients without the presence of users at their PCs. To read more about automated installation, see *IBM DB2 Content Manager OnDemand: Windows Client Customization Guide*.

**Installing user-defined files**

Administrators can store user-defined files in the OnDemand installation directory tree on a network file server. Any user-defined files stored there get copied to the PC when a user runs the Setup program from the server. To read more about installing user-defined files, see *IBM DB2 Content Manager OnDemand: Windows Client Customization Guide*.

**Mapping AFP fonts**

To view AFP documents, you may need to map the AFP fonts your documents were created with to fonts that can be viewed on the PC. That way, OnDemand can display the documents and fonts correctly. You should define the fonts in font definition files if your documents use:

- AFP fonts that are not defined to OnDemand
- IBM AFP fonts that you or others in your organization have changed
- AFP fonts that you or others in your organization have created

To read more about mapping AFP fonts, see *IBM DB2 Content Manager OnDemand: Windows Client Customization Guide*. 
Chapter 4. Updating client software

Note: When you upgrade the client, the Setup program automatically replaces all out-of-date files with new ones. You are not permitted to add or remove components. To add or remove components, you must run the Setup program after you successfully upgrade the client.

You can use the following information to obtain and install the latest version of the OnDemand client software from IBM service on the World Wide Web.

To get the latest version of the client software:
1. Point your browser to:
   ftp://service.software.ibm.com/software/ondemand/fixes
   Follow the links to the latest PTF for your client.
2. Click the ZIP file for the client that you want to upgrade. For example:
   odwin32.zip
3. Select to save the file to disk.
4. Select a location and save the file.

After the download is complete, you can expand the ZIP file or store the ZIP file in a shared location, depending on how you plan to distribute the client software:

• You can expand the ZIP file to a temporary directory and then run the Setup program to upgrade the client on a PC. After installing the client, you can delete the temporary directory and the ZIP file.

• An administrator can store the ZIP file in a shared location so that other users can access it.

• An administrator can expand the ZIP file to a shared location so that other users can run the Setup program from the shared location.

• If your organization shares a copy of the OnDemand client software from a network server, then an administrator can expand the ZIP file and run the Setup program to upgrade the client on the server.

• If your organization distributes user-defined files with the OnDemand client, an administrator must expand the ZIP file to a shared location and then copy the user-defined files to that location. Users can then run the Setup program from the shared location to upgrade the client software and the user-defined files on their PCs.
Chapter 5. Configuring OnDemand Version 7.1 client to access an OnDemand for OS/390 Version 2.1 server

The IBM Content Manager OnDemand for OS/390 Version 2.1 server must support the OnDemand Windows client level that is installed. Before you install the client, you must make sure that your server maintenance level supports the client that you plan to install. Later releases of the server display supported clients during server initialization.

To enable the client to access an OnDemand for OS/390 Version 2.1 server, you need to configure the client and define some settings. These settings may be defined during setup, through the setup.ini file, or later through a manual process.

To configure OnDemand Version 7.1 client to access a OS/390 Version 2.1 server, complete the following steps:

1. **Optional but recommended**: Specify settings in the setup.ini file that are necessary for the OnDemand for OS/390 Version 2.1 server.
2. Add the OnDemand for OS/390 Version 2.1 required command line parameters. You can add the parameters in the setup.ini file, or manually follow installation steps. After you add the parameters, make sure that the shortcut properties target field is updated with these parameters.
3. **Required for OLE**: Use the SetFolderCloseMemoryRelease method.
4. **Optional but recommended**: Configure the client to run in short sockets mode for better performance. This may be automated through the setup.ini file, or this process may also be done manually.
5. In the Update Servers window, uncheck the Attempt Unified Logon check box unless this option is needed for a specific purpose.

**Step 1: Recommended: Specifying settings in the setup.ini file**

The setup.ini file is used when you run Setup to install the OnDemand client with certain options. You can add an [S390] section to automatically install the client to connect using short sockets mode, and add to the OnDemand client shortcut the parameters that are required by OnDemand for OS/390 Version 2.1. For example,

[S390]
Sockets=User
Parameters=/Q /O 1 /9

The short sockets mode is recommended for better performance, and the command-line parameters are required when you connect to an OnDemand for OS/390 Version 2.1 server.

**Sockets=Local**

Placed the Disconnect=1 short sockets parameter in the Windows registry HKEY_CURRENT_USER registry key.

**Sockets=Local**

Place the Disconnect=1 short sockets parameter in the Windows registry HKEY_LOCAL_MACHINE registry key. For OnDemand on Windows NT® and
Windows 2000 systems, where multiple users need to log on to the operating system with separate IDs, this option is recommended.

Parameters
In addition to the required command line parameters that are listed in the above example, you may add other command line parameters to the [S390] section. See “Step 2: Required: Adding the required command line parameters” for more information. For example:

Parameters=/Q /O 1 /9 /S servername

Step 2: Required: Adding the required command line parameters

You must add several command-line parameters for the OnDemand Windows client to work properly when accessing an OnDemand for OS/390 Version 2.1 server. The command-line parameters may be added automatically by using the Setup.ini process described above, or they may be added manually to the OnDemand shortcut. An example of the target for the OnDemand shortcut is:

C:\Program Files\IBM\OnDemand32\ARSGUI32.EXE /1 C:\Program Files\IBM\OnDemand32 \LOCAL\ENU /Q /O 1 /9

where

/O 1 – Maximum open folders
OnDemand for OS/390, V2.1 limits the number of open folders to one.

/Q – Frees memory when a folder is closed
OnDemand for OS/390 Version 2.1 frees all memory that is associated with a folder when it is closed, and refreshes the folder information from the server when it is reopened.

/9 – Additional OnDemand for OS/390 parameters
If you add this parameter, the Public Note check box is checked and disabled. All notes in OnDemand for OS/390 Version 2.1 are public. The "Note can be copied to another server" check box is checked and disabled. This allows notes to be saved with the ad-hoc cdrom feature. Also, from the Document Hitlist, server print is enabled, and local and LAN print are disabled. While viewing the document, local, LAN, and server print are all enabled.

Step 3: Required for OLE: Using the SetFolderCloseMemoryRelease method

If you are interested in implementing OLE Controls, you must use the SetFolderCloseMemoryRelease method when a folder is closed for OnDemand for OS/390 Version 2.1. This is the equivalent of the required /Q command line parameter that is described in "Step 2: Required: Adding the required command line parameters”.

Step 4: Recommended: Configuring the client to run in short sockets mode

When the OnDemand client is installed, it is set up to start the server as a long running task (long sockets). For maximum performance, you can change the default setting from long running task (long sockets) to short running task (short sockets).
DISCONNECT = 1 is the parameter for short sockets, and DISCONNECT = 0 is the parameter for long sockets (default). There are two options to configure short sockets:

- Using the Setup.ini directory processes to configure short sockets automatically
- Manually configuring short sockets

For more information about how to use the Setup.ini directory processes to configure short sockets automatically, see "Step 1: Recommended: Specifying settings in the setup.ini file".

To manually configure short sockets, you must edit the Windows System Registry (REGEDT32). **Important:** You must be familiar with editing the Windows Registry. Follow these steps:

1. Make sure that the OnDemand client is installed on your PC.
2. Select Start -> Run, and open regedit.
3. In regedit, select HKEY_CURRENT_USER or HKEY_LOCAL_MACHINE -> Software -> IBM -> OnDemand32 -> Common -> Servers.
4. Click Servers, you should see entries for Default and SERVERS.
5. Right-click the right side of the screen.
7. Enter Disconnect.
8. Double-click Disconnect, then enter 1 for short sockets or 0 for long sockets.

**Step 5: Clearing the Attempt Unified Logon check box in the Update Servers window to access an OS/390 server**

After you launch the OnDemand client, in the Update Servers window, make sure that the Attempt Unified Logon check box is not selected. A unified logon is only valid when the OnDemand server is in a Windows environment. If you are connecting to OnDemand on OS/390, you should not select it.
Chapter 6. Starting the OnDemand client

**Important:** Your system may be configured to start the OnDemand client automatically. For example, some customers configure systems so that after a user starts the system, the client opens the Logon to a Server window. If you do not have to start the client, skip this section and go to Chapter 7, “Logging on to a server,” on page 19.

You can start the OnDemand client in different ways. Here are some of the most common ways:

- “Starting from the desktop” on page 16
- “Starting from the Start menu” on page 17
- “Starting from the Run command window” on page 17

Optional: Specifying startup parameters

OnDemand provides parameters that you can specify as properties for starting the client program. You can use the parameters to automate the logon process, and configure other properties of the client. Table 4 lists the most commonly used parameters for the client program.

**See also:** See IBM DB2 Content Manager OnDemand: Windows Client Customization Guide for a complete list of the parameters that can be specified when starting the client.

**Table 4. Client program parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Purpose</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/F folder</td>
<td>Identifies the folder to open. Use with the /P, /S, and /U parameters to automatically log on to a server and display the Search Criteria and Document List window for the specified folder. If the specified folder is not found on the server, OnDemand displays the Open Folder window.</td>
<td>/F Student Information</td>
</tr>
<tr>
<td>/P password</td>
<td>The password for the userid identified by the /U parameter. Use with the /S and /U parameters to log on to a server without displaying the Logon to a Server window. If the logon is not successful, OnDemand allows the user to log on to the server by displaying the Logon to a Server window.</td>
<td>/P xxxxxxxx</td>
</tr>
</tbody>
</table>
Table 4. Client program parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Purpose</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/S server</td>
<td>Identifies the OnDemand server. Use with the /P and /U parameters to log on to a server without displaying the Logon to a Server window. If the logon is not successful, OnDemand allows the user to log on to the server by displaying the Logon to a Server window.</td>
<td>/S peluchage</td>
</tr>
<tr>
<td>/U userid</td>
<td>Identifies the OnDemand user ID. Use with the /P and /S parameters to log on to a server without displaying the Logon to a Server window. If the logon is not successful, OnDemand allows the user to log on to the server by displaying the Logon to a Server window.</td>
<td>/U csr0008</td>
</tr>
</tbody>
</table>

Specifying parameters

To specify parameters for the client program:

1. Locate the shortcut for the OnDemand client program on the desktop, in the Start menu, or in the OnDemand program folder or group.
2. Open the program Properties window.
3. In the Target field, type the parameters that you wish to use.

**Important:** Make sure that you add any parameters after the path name of the language Dynamic Link Library (DLL). See your OnDemand administrator if you have questions.

The following is an example:

"C:\Program Files\IBM\OnDemand32\ARSGUI32.EXE"
/I C:\Program Files\IBM\OnDemand32\LOCALE\ENU
/S peluchage /U csr0008 /P XXXXXXXX /F Student Information

In the example, the /S, /U, /P, and /F parameters are added to the Target field.
4. Click OK to save your changes.

Starting from the desktop

To start the OnDemand client from the desktop, follow these steps:

1. Locate the OnDemand icon on the desktop.
2. Double-click the OnDemand icon to open the Logon to a Server window.

OnDemand needs to know certain information to begin communicating with a server. OnDemand collects this information in the Logon to a Server window. For more information about logging on, see [Chapter 7, “Logging on to a server,” on page 19](#).
Starting from the Start menu

To start the OnDemand Windows client from the Start menu, select Start —> Programs —> IBM OnDemand32 to start the client and open the Logon to a Server window.

OnDemand needs to know certain information to begin communicating with a server. OnDemand collects this information in the Logon to a Server window. For more information about logging on, see Chapter 7, “Logging on to a server,” on page 19.

Starting from the Run command window

To start the OnDemand Windows client from the Run window, follow these steps:

1. Select Start —> Run to bring up the Run window.
2. Type the full path name of the OnDemand client program (the drive and folder, followed by arsgui32.exe, and optionally the language and other startup parameters). If you do not know the path, click Browse to select it.
3. Click OK. Windows closes the Run window. OnDemand starts and opens the Logon to a Server window.

OnDemand needs to know certain information to begin communicating with a server. OnDemand collects this information in the Logon to a Server window. For more information about logging on, see Chapter 7, “Logging on to a server,” on page 19.
Chapter 7. Logging on to a server

Important: Your system may be configured to automatically log on to a specific OnDemand server. For example, some customers configure systems so that after a user starts the client, the client opens the Open a Folder window. If you do not have to log on to a server, skip this section and go to Chapter 9, “Opening folders,” on page 27.

To logon to an OnDemand server, follow these steps:

1. If the Logon to a Server window is not active in the OnDemand workspace:
   Select Logon from the File menu to open the Logon to a Server window.

2. If your OnDemand administrator configured the client with the name of your OnDemand server, the server name appears in the Server field. (If your administrator configured the client with the names of several servers, all server names appear in the list. Select a server name from the drop-down list.)
   If there are no servers listed or if the name of the server that you need to log on to is not in the list, then click Update Servers to open the Update Servers window. See Chapter 8, “Updating server information,” on page 21 for more information about adding servers to the list.

3. Type your OnDemand User ID and Password into the spaces provided. For example:

4. Click OK to log on to the server. OnDemand verifies your OnDemand User ID and password on the server. When your OnDemand User ID and password are verified, OnDemand opens the Open a Folder window. See Chapter 9, “Opening folders,” on page 27 for information on opening folders.
Chapter 8. Updating server information

This section describes how to add, update, and delete the servers that you can access from the client. Before you proceed, see your OnDemand administrator for information about servers that you can access with your client, including:

- Types of servers
- Communications protocols
- Other details that you need to work with OnDemand servers

Use the Update Servers command from the Logon to a Server window:

- To add a server to the list of servers you can access
- To change information for a server that you can access
- To delete a server from the list of servers that you can access

You can change information for TCP/IP servers and Local servers.

The first time that you start OnDemand, the Server field on the Logon to a Server window may not contain any entries. Check with your OnDemand administrator for a list of the servers that you can use.

Updating information for TCP/IP servers

Adding a TCP/IP server

1. In the Logon to a Server window, click Update Servers to open the Update Servers window. For example:

   ![Update Servers window](image)

2. In the Server field, type the name of the OnDemand library server to add the name of a server to the list of available servers. The server name can be a TCP/IP host name alias, fully-qualified host name, or IP address.

3. **Optional:** In the Host Name field, enter the TCP/IP host name alias, fully-qualified host name, or IP address of the OnDemand library server. By default, the Host Name field contains the same value as the Server field. Unless you have a good reason to change the Host Name, we recommend that you use the default provided.

4. From the Protocol list, select TCP/IP, if it is not already selected.
5. Verify the Port. This should be the TCP/IP port number that the client and server use to communicate.
   The default value, 0 (zero), means that OnDemand uses the port number of the
   OnDemand service. Unless you have a good reason to change the Port, we
   recommend that you use the default provided. See your administrator for more
   information.

6. If the server you are adding runs on Windows, select Attempt Unified Logon.
   Otherwise, clear the Attempt Unified Logon check box.

7. When complete, click Add.
   If you do not want to add the server, click Close instead to return to the Logon
   to a Server window.

8. Click Close to close the Update Servers window and return to the Logon to a
   Server window

**Changing a TCP/IP server**

1. In the Logon to a Server window, click Update Servers to open the Update
   Servers window. For example:

   ![Update Servers window]

   2. From the Server drop-down list, select the server name.
   3. Make your changes.
   4. When complete, click Update.
      If you do not want to make any change, click Close instead of Update to return
      to the Logon to a Server window without making any changes.
   5. When you have finished making changes for the server you are working with,
      click Close to return to the Logon to a Server window.

**Updating information for local servers**

There are three kinds of local servers:
- CD-ROM
- Network
- Hard Drive

**Adding a CD-ROM server**

1. In the Logon to a Server window, click Update Servers to open the Update
   Servers window. For example:
2. In the Server field, type the name of the server. For example, suppose the drive letter of your CD-ROM is D:, you can name the server CD-ROM-D. If you have more than one CD-ROM drives, OnDemand uses the name to select the CD-ROM drive that contains the server.

3. From the Protocol list, select Local.

4. In the Directory field, enter the drive letter that is associated with the CD-ROM (for example, d:).

5. Clear the Attempt Unified Logon check box.

6. When complete, click Add to add the server to the Server list.

   If you do not want to add the server, click Close instead to return to the Logon to a Server window.

7. Click Close to close the Update Servers window and return to the Logon to a Server window.

Adding a network or hard drive server

1. In the Logon to a Server window, click Update Servers to open the Update Servers window. For example:

2. In the Server field, type the name of the server. For example, netusers or hdusers.

3. From the Protocol list, select Local.

4. In the Directory field, enter the directory or directory path to the server files.

5. Clear the Attempt Unified Logon check box.

6. When complete, click Add to add the server to the Server list.
If you do not want to add the server, click Close instead to return to the Logon to a Server window.

7. Click Close to close the Update Servers window and return to the Logon to a Server window.

**Changing a local server**

1. In the Logon to a Server window, click **Update Servers** to open the Update Servers window. For example:

![Update Servers Window](image)

2. From the Server list, select the server name.
3. Make your changes.
4. When complete, click **Update** to change the information for the server you selected.

If you do not want to make any change, click Close instead of **Update** to undo any changes and return to the Logon to a Server window.

5. When you have finished making changes for the server you are working with, click Close to the Logon to a Server window.

**Deleting a server**

To delete a server from the list of servers that you can access, follow these steps:

1. From the Logon to a Server window, click **Update Servers** to open the Update Servers window. For Example:

![Update Servers Window](image)

2. From the Server list, select the server name that you want to delete.
3. Click **Delete**. OnDemand removes the server from the list of servers that you can access.
   If you do not want to delete the server, click **Close** instead to return to the Logon to a Server window.
4. Click **Close** to close the Update Servers window and return to the Logon to a Server window.
Chapter 9. Opening folders

Important: OnDemand opens the Open a Folder window only if there is more than one folder to choose from. Otherwise, OnDemand opens the Search Criteria and Document List window immediately after you log on to the server. If you do not have to choose folders, skip the following steps and go to Chapter 10, “Searching for documents,” on page 29.

To open a folder, follow these steps:

1. If the Open a Folder window is not open in the OnDemand workspace, open it now:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select File —&gt; Open Folder</td>
<td>Click</td>
<td>Press Ctrl+O</td>
</tr>
</tbody>
</table>

   The folders that you can access are listed in the Open a Folder window. For example:

   ![Open a Folder window]

2. To open a folder, double-click the folder name or use the arrow keys on your keyboard to move to the folder name and then press Enter. OnDemand opens the Search Criteria and Document List window.

   Tip: You can have more than one folder open at the same time. It is not necessary to close a folder before you open another. While you are working with more than one folder, OnDemand lists the open folders in the Window menu, and you can click one of them to make it the active folder.

In addition to opening folders, you can complete the following tasks from the Open a Folder window:

Find  
Use to open the Find window and search for a folder. From the Find window, enter the text that you want to search for. The client moves to the first folder in the list that contains the text in the name or description. Use the Find Next and Find Previous commands to repeat the last find operation and move to the next or previous folder in the list that contains the text.
Show Folders  Use to list the primary folders or all of the folders that are on the server. When you log on to a server, the client lists only the primary folders. To list all folders, including secondary folders, select All. If there are no secondary folders that are defined on the server, then the Show Folders option is not available (and all of the folders on the server are listed). An administrator determines which folders are secondary folders.

Filter...  Use to update the list of folders based on the criteria that you select. When you click Filter... in the Open a Folder window, the Folder Filter List window opens. Available options include:

Show All Names
Select this check box if you want the result list to include all folder names that are available to you. If this check box is selected, the Filter for Folder Names section is greyed out. If this check box is not selected, you should enter the folder name in the Filter for Folder Names field or select an existing folder name from the drop down list.

Add To Current List
Select this check box if you want to add the new folders to the existing folder list. If this check box is not selected, the results of this operation replace the existing folder list.

Filter for Folder Names
Enter the folder name or names that you want to replace or add to the existing folder list.

• You can use the SQL wildcard characters % and _ in the name or names. For example, if you enter CR%, you should see all folder names that begin with CR.
• Quotation marks can be used as a separator between folder names. For example, if you enter "Loan%"System Log"Credit% the system returns all folder names that begin with Loan, the specific folder name System Log, and all folder names that begin with Credit.
• The entry field does not accept more than 2000 characters.
Chapter 10. Searching for documents

Overview

In the OnDemand client, you can search for documents in the Search Criteria and Document List window. The title bar shows the name of the folder that you opened. In the example that follows, the name of the folder is Baxter Bay Credit.

Important: To open the Search Criteria and Document List window, see Chapter 9, “Opening folders,” on page 27.

The Search Criteria area contains fields, controls, and commands that you can use to search for documents:

Field names
The number and names of the fields vary by folder. In the example, there are four search fields: Account, Name, Balance, and Date.

Operators (one active for each field)
In the example, the operator for the Date field is Between. OnDemand uses standard Structured Query Language (SQL) search operators to search for documents. Click a search operator button to list all of the search operators that are available for the field.

Note: The search operators that are available for a field are set by an OnDemand administrator and can vary by folder and field.

Entry fields
Places for you to type search values (such as text, numbers, and dates). When a search entry field has a ↓, click the ↓ to select from pre-set choices.
Commands:

**Search**
Use to initiate a search.

**Clear All Fields**
Use to erase the values from all of the search fields.

**Restore Defaults**
Use to set the search operators and the contents of the search fields to the values that appeared when you first opened the folder.

Logical operator

**AND** means that the search must match all of the search criteria. **OR** means that the search must match at least one of the search criteria. Unless you have a good reason for doing so, do not change the Logical operator.

The Document List area lists the documents that match the search criteria and contains controls for working with documents. See Chapter 11, “Working with documents,” on page 33 for more information.

---

**Searching for documents**

To search for documents, follow these steps:

1. Type search values (for example, an account, name, balance, or date) into one or more search entry fields:
   - Press **Tab** to move from one entry field to another. You do not have to type a value in every entry field. However, you may need to type a value in at least one entry field. See your OnDemand administrator if you have questions about required field values.
   - You can use wildcard characters with the **Like** and **Not Like** search operators to represent other letters, numbers, or special characters. OnDemand uses two wildcard characters. The _ (underscore) character matches any single letter, number, or other special character. For example, if you type 1_0 in a search field, OnDemand finds 100, 110, 120...190. The % (percentage) character matches zero or more letters, numbers, or other special characters. For example, if you type MARS% in a search field, OnDemand finds MARS, MARSC, MARSHEL, MARSTEENS, and so forth.
   - **If a description is provided for a folder field in the administrative client:** A popup tool tip that contains description about the corresponding search criteria name is displayed when you move the mouse over the search criteria name. If the description has no non-space characters, no tooltip is displayed.
   - A required search criteria name is denoted by an asterisk * in front of it.

2. Select search operators for each search field. Choose the search operator button to list the full range of operators available for each field. Select a search operator for a field by choosing one of the buttons in the Select Operator window.

3. Click **Search**. OnDemand fills the Document List with the documents that match the search criteria and updates the status bar with a count of the number of documents. OnDemand lists the documents in the order that they occur on the server or the order that is chosen by the OnDemand administrator.

4. OnDemand prints the following message on the status bar when it is searching the database:

   Search is proceeding ... *nnn* documents have been selected.

   where *nnn* is the number of documents that have satisfied the search criteria.
If you need to stop a search:

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Press Spacebar</td>
</tr>
</tbody>
</table>

Most search requests process quickly. However, complex search requests may take several minutes to complete. The more specific the search criteria that you use, the less time OnDemand requires to complete a search. For example, searching using the Equal operator (for example, Equal MARSHAL) takes less time than searching using the Like operator (for example, Like MARSHAL\%).

If you configured Autoview (on the Options menu) for First Document, then OnDemand automatically opens the first document from the list of documents that match the search criteria. If you configured Autoview for Single Document and only one document matches the search criteria, then OnDemand automatically opens the document for you.
Chapter 11. Working with documents

Overview

Select the documents that you want to work with from the Search Criteria and Document List window.

Important: To open the Search Criteria and Document List window, see Chapter 10, “Searching for documents,” on page 29.

The documents that meet the search criteria are listed in the Document List area. Use the scroll bars or arrow keys on your keyboard to move to a specific document in the list.

Use the Document List commands to work with documents:

View All Selected
Use to view the documents that you selected. If you select more than one document, then OnDemand reads each document into a separate viewing window.

Print All Selected
Use to print the documents that you selected.

Sort List
Use to resequence the documents in the Document List.

Append
Use to add lists of documents after those already in the Document List. By default, every time that you click Search, OnDemand replaces the documents listed with the documents that match the search.
AutoScroll

Use to automatically scroll the Document List as search results are found.

Note: The AutoScroll check box is not included on the Search Criteria and Document List window when the documents in the Document List are generated in sorted order.

The number of documents that you can view at the same time is determined by system resources and the types of documents that you want to view. Typically fewer AFP documents can be opened at one time, while a larger number of line data documents can be opened at one time. Experiment to determine how many documents that you can open at one time. OnDemand reads each document that you select into a separate viewing window.

OnDemand uses the Autoview command to determine whether to automatically open a document after completing a search. You can configure the Autoview command from the Options menu:

- **None**: OnDemand does not automatically open a document found by a search. None is the default setting.
- **First Document**: OnDemand automatically opens the first document from the list of documents that match the search criteria.
- **Single Document**: When only one document matches the search criteria, OnDemand automatically opens it for you.

### Selecting documents for viewing

To select documents for viewing, follow these steps:

1. From the Document List area of the Search Criteria and Document List window, select the document or documents that you want to view.
2. Click **View All Selected**. OnDemand opens the selected documents, each in a separate window.

When you select multiple documents for viewing, OnDemand opens the following message on the status bar:

   Document retrieval is proceeding for document name.

If you need to stop the retrieval of the current document and any remaining documents:

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Press Spacebar</td>
</tr>
</tbody>
</table>
Working with more than one document

If you work with more than one document at a time, the following commands can help you move between open documents, open other documents from the Document List, and return to the Search Criteria and Document List window (to select more documents or search for more documents).

To move between open documents, use one of the following methods:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the document number (1, 2, 3, ...) from the Window menu</td>
<td>• Click</td>
<td>Press Alt+W to activate the Window menu. Then press the key that corresponds to the document (1, 2, 3, ...).</td>
</tr>
<tr>
<td></td>
<td>• Click</td>
<td></td>
</tr>
</tbody>
</table>

To open documents from the Document list while you are viewing a document, use one of the following methods:
Menus | Toolbar | Keyboard
--- | --- | ---
* Select Previous Item in Document List from the Window menu | • Click | • Press Alt+F9
* Select Next Item in Document List from the Window menu | • Click | • Press Alt+F10

Restriction: These methods close the document that you are viewing before opening another document.

To return to the Search Criteria and Document List window when you are viewing a document, use one of the following methods:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the folder name from the Window menu</td>
<td>Click</td>
<td>Press Ctrl+D</td>
</tr>
</tbody>
</table>

**Viewing documents**

This section shows you how to complete some basic document tasks, such as:

* Moving to pages in a document
* Finding information in a document
* Adding a note to a document

**Moving to pages in a document**

When the document that you are viewing contains more than one page, you can move to different pages in the document (“navigate the document”) in different ways. We’ve listed some of the most common:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
</table>
| Select Go To from the Search menu to move to a specific page in the document you are viewing | • Click | • Press F4 to move to a specific page in the document that you are viewing
| Select Previous Page from the Search menu to move to the previous page | • Click | • Press F7 to move to the previous page
| Select Next Page from the Search menu to move to the next page | • Click | • Press F8 to move to the next page
| Select First Page from the Search menu to move to the first page of the document | • Click | • Press Ctrl+Home to move to the first page in the document
| Select Last Page from the Search menu to move to the last page | | • Press Ctrl+End to move to the last page in the document
When you choose the Go To command, OnDemand opens the Go To window for you to pick the page to move to.

**Finding information in a document**

Use the Find window to locate information in the document that you are viewing. For example, if the document that you are viewing contains hundreds (or thousands) of customer names, you can use the Find command to locate a specific customer name. You can then use the Find Next and Find Previous commands to move to other occurrences of the customer name in the document.

To begin finding information in a document:
1. Open the Find window by using one of the following methods:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Search —&gt; Find</td>
<td>Click</td>
<td>Press F5</td>
</tr>
</tbody>
</table>

2. Enter the information you want to find in the String field. Click Help to get online Help about the information that you can enter and other options on the Find window.
3. When you are ready, click Find. OnDemand moves to the first occurrence of the string in the document.
4. You can move to other occurrences of the Find String in the document by using one of the following methods:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Select Search —&gt; Find Previous</td>
<td>• Click</td>
<td>• Press Ctrl+R</td>
</tr>
<tr>
<td>• Select Search —&gt; Find Next</td>
<td>• Click</td>
<td>• Press Ctrl+N</td>
</tr>
</tbody>
</table>

**Adding notes to a document**

In OnDemand, an *annotation* is an electronic note that an authorized user can attach to a document. The note can contain information such as clarifications and reminders about a document, discussions about a document, or any other information that you want to attach to a document.

**Requirement**: An OnDemand administrator must give a user permission to add, update, and delete notes.

---

2. The note is not physically attached to the document. Rather, it is stored in a separate place than the document. The system keeps track of notes and the client will indicate when a note exists for a document and retrieve it upon request. A note remains attached to a document so long as no one deletes the note, until the document is deleted from the system.
When you want to add a note to a document or view the notes to a document, use one of the following methods:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Select Notes —&gt; Add Notes to add a note to the document that you are viewing</td>
<td>Click</td>
<td>• Press Ctrl+A to add a note to the document that you are viewing</td>
</tr>
<tr>
<td>• Select Notes —&gt; View Notes to view existing notes</td>
<td></td>
<td>• Press Ctrl+N to view existing notes</td>
</tr>
</tbody>
</table>

After you choose the Add Notes command, OnDemand opens the Add a Note window. Click Help in the Add a Note window to learn more about the options for notes.

After you choose the View Notes command, OnDemand opens the Notes window. From the Notes window, you can read existing notes, add your own notes, and delete notes; you can also search notes. Click Help in the Notes window to learn more about working with notes.

### Printing and faxing documents

This section describes how to print and fax documents.

You can print or fax the page of the document that you are viewing, selected pages of a document, or the entire document. You can also select, print, or fax documents from the document list.

You initiate a print or fax request in OnDemand by using the Print command, to open the Print window. To fax a document, you must select the Server option in the Print window. See the online help for detailed information about the options available from the Print window.

If you have questions about printers, ask your OnDemand administrator. If you have questions about selecting printers or changing printer options, see the online help. For detailed information about printing, see your operating system documentation.

### Printing from a document

To print pages of the document that you are viewing, follow these steps:

1. Open the Print window by using one of the following methods:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select File —&gt; Print</td>
<td>Click</td>
<td>Press Ctrl+I</td>
</tr>
</tbody>
</table>

2. Select a printer and specify printing options. See the online help for details.

   **Tip:** When you print from a document, you can print all of the pages of the document, the page that you are currently viewing (the default choice), or selected pages of the document. When you fax a document, you have the
opportunity to specify information that is placed on a cover page. You can also save and retrieve sender and recipient information.

3. When you are ready to proceed, click **Print**.

**Printing from the Document List**
To print one or more documents from the Document List, follow these steps:

1. From the Document List area of the Search Criteria and Document list window, select the document or documents that you want to print.
2. Click **Print All Selected** to open the Print window.
3. Select a printer and specify printing options. See the online help for details.
   
   **Tip:** When you print a document from the Document List, OnDemand automatically prints all of the pages of the document.
4. When you are ready to proceed, click **Print**.

**Restriction:** You cannot print documents from applications with user defined types directly from the document list.

---

**Sending documents**

OnDemand provides an interface to the mail client on the PC so that you can use e-mail to send copies of documents to people outside of your organization or to people that do not have access to OnDemand. You e-mail a document to someone by using the Send command.

**Important:** The Send function requires that a Mail Application Programming Interface (MAPI) client be installed on the PC. For example, an MAPI client is installed with Lotus® Notes® 5.08 or later; Netscape Navigator 4.06 or later also includes an MAPI client that you can use to send documents. See your OnDemand administrator for more information about installing and configuring MAPI clients.

To send the document that you are viewing, follow these steps:

1. Open the Send window using one of the following methods:

   **Menus**  
   Select **File —> Send**

   **Toolbar**  
   Click

2. Specify the sending options. See the online help for details.
   
   **Tip:** When you send a document, by default, OnDemand automatically sends all of the pages of the document. However, you can use the Use Selected Area As Text option to send part of the document. (You must select the part of the document before you choose the Send command.)

3. When you are ready to proceed, click **OK**. OnDemand starts the default mail client.
4. Specify a recipient. Enter message text and change the subject of the message, if you like.
5. When you are ready to send the message, click **Send** in the mail client.
Sending from the Document List

To send one or more documents from the Document List, follow these steps:

1. From the Document List area of the Search Criteria and Document list window, select the document or documents that you want to send.
2. Click the **Send** in the toolbar, or select **File —> Send** to open the Send window.
3. Specify the sending options. See the online help for details.

**Tip:** When you send a document from the Document List, OnDemand automatically sends all of the pages of the document.

4. When you are ready to proceed, click **OK**. OnDemand retrieves the documents and then starts the default mail client.

When you select multiple documents, OnDemand prints the following message on the status bar:

Document retrieval is proceeding for *document name*.

If you need to stop the retrieval of the current document and any remaining documents:

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Press Spacebar</td>
</tr>
</tbody>
</table>

5. In the mail client, specify a recipient. Enter message text and change the subject of the message, if you like.

6. When you are ready to send the message, click **Send** in the mail client.

---

**Viewing document properties**

To view the properties of a document, right-click a document from the Document List, and click **Properties**. For example:
The Document Properties window is displayed, which contains the following information about that document:

**Name**  Name of the document. It is same as the document name that is included on the title bar when the document is active.

**Type**  Document type. Document types include:
- AFP
- Line
- BMP
- GIF
- PCX
- TIFF
- PDF
- None
- JFIF
- User Defined
- OD Defined
- E-MAIL
- SCS
- SCS-Extended
- Metacode
- PNG
- DJDE
- Unknown

**Extension**  File extension associated with a document of the type User Defined. For all other document types, N/A is displayed.

**Application Group**  Name of the application group that is associated with the document.

**Application**  Name of the application that is associated with the document.

**Partial Load ID**  Partial load ID of the document. The partial load ID includes the following:
- Application group identifier
- Primary and secondary node identifiers
- Load identifier within the application group

**Note:**
- The partial load ID does not include the earliest and the latest date in the report.
- If you use ARSADMIN for unload operations, the earliest and latest dates might be required. Typically, you can obtain them from the System Log folder. If you perform a search within an approximate date range and specify `Msg Num Equal To 87` and `Message Like %partial load id%`, the full Load ID is displayed in the Message column.
Large Object
If the document is a large object, Yes is displayed. If the document is not a large object, No is displayed.

Pages/Segment
For Large Objects that have been retrieved, the number of pages per segment is displayed. For Large Object documents in the search results, Information not available is displayed. For other documents, N/A is displayed.

The following is an example of the Document Properties window:
Chapter 12. Using the CD-ROM as an OnDemand server

OnDemand enables system administrators to extract data from an OnDemand server, and put the data onto CDs, which are easily distributable. In this case, each CD-ROM becomes an OnDemand server, and the way you access data from a CD-ROM is almost indistinguishable from the way you access the same data from a full-blown OnDemand server.

Before you can use the CD-ROM, you need to install it. To install a CD-ROM, run \x:\install\setup.exe, where x:\ is the drive letter of the CD-ROM.

The setup program copies the necessary files to your hard drive, and creates the Windows icons that you need. The OnDemand client software stays on the CD-ROM, and you should access the client from there.

The OnDemand client on the CD-ROM is the same as the regular OnDemand client that you install on your workstation. However, in this scenario, the server is local rather than TCP/IP attached.

Restriction:

- You cannot change your password if you are using a CD-ROM.
- Annotations and named queries are stored locally on your hard drive rather than on the CD-ROM.
- When you do a search, the And or Or logical operator are not displayed.
Chapter 13. Ending your OnDemand session

This section describes different ways that you can close documents and folders and log off the OnDemand server.

Closing documents

You can close documents in different ways. We’ve listed some of the most common:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbar</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Select File —&gt; Close to close the document that you are viewing</td>
<td>• Click</td>
<td>• Press F3 to close the document you are viewing</td>
</tr>
<tr>
<td>• Select File —&gt; Close All Documents to close all open documents</td>
<td>• Click to close the document that you are viewing and open the previous document in the Document List.</td>
<td>• Press Alt+F3 to close all open documents</td>
</tr>
<tr>
<td>• Select File —&gt; Close Folder to close a folder and all open documents from the folder.</td>
<td>• Click</td>
<td>• Press Alt+F4 to close all open documents and folders, log off the server, and exit OnDemand</td>
</tr>
<tr>
<td>• Select File —&gt; Exit OnDemand to close all open documents and folders, log off the server, and exit OnDemand</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Closing folders

Use one of the following methods to close a folder without logging off the server or exiting OnDemand:

• In the Search Criteria and Document List window, click Close Folder.
• Select File —> Close Folder.
• Select File —> Close All Folders.

Tip: If you have more than one folder open, and you select File —> Close Folder, OnDemand closes the current folder. (OnDemand places a check next to the current folder in the Window menu.)

Logging off a server

To log off a server, select File —> Logoff.

Stopping OnDemand

You can stop the OnDemand client in different ways. Here are some of the most common ways to stop the OnDemand client:

<table>
<thead>
<tr>
<th>Menus</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select File —&gt; Exit OnDemand</td>
<td>Press Alt+F4</td>
</tr>
</tbody>
</table>
Chapter 14. Removing the OnDemand client

The Uninstall feature lets you remove the OnDemand client from your PC. Uninstall removes the directories for OnDemand and any references to OnDemand in system files. To run uninstall:

2. From the list, select OnDemand32.
3. Click Add/Remove.
4. Click OK.
Chapter 15. Adding or removing OnDemand client components

1. Start the OnDemand client Setup program. The Welcome screen opens, with the Modify option is selected.
2. Click Next.
3. To add a component, select it from the list; to remove a component, clear it from the list. You can also add and remove specific languages, fonts, and other options.

   **Note:** When you add a component, make sure that you leave the existing components selected. If you clear the check from a component, the Modify process removes it from the PC.
4. Click Next.
5. Verify the components.
6. Click Next and follow the instructions on the screen to finish.
Chapter 16. Troubleshooting

Troubleshooting scenario 1: Documents in another language are not correctly displayed

Symptom
You cannot view documents in another language correctly with OnDemand client on English Windows 2000, even though the locale is set as the target language.

Possible causes
It is possible that your `locale(location)` or `-default"system locale"` (or both) is not set as the target language.

Action
Make sure that both your `locale(location)` and `-default"system locale"` are set as the target language.

Troubleshooting scenario 2: AFP plugin fails with a back level OnDemand client

Symptom
You upgraded the AFP plugin on your computer to the version that came with a recent fixpack, and after that, you were not able to view AFP documents through the Web.

Possible causes
Newer versions of the AFP plugin use the iconv tables. If your OnDemand client is back level, it is possible that your system does not have the iconv tables.

Action
Upgrade your OnDemand client so that the registry can be fixed. After that, you should be able to get to the iconv tables with the AFP plugin.

Troubleshooting scenario 3: The Send To function is disabled even after MAPI is installed

Symptom
The "Send To" function in the client is disabled even after you installed MAPI.

Possible causes
Your Windows Messaging Subsystem registry key is set to 0.

Action
Check the following registry key:
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows Messaging Subsystem

Make sure that the value is not 0.

**Troubleshooting scenario 4: Errors occurred while trying to view a PDF document**

**Symptom**

You have the full Acrobat Version 6 on your system, however, you received the message Unable to Initialize Document or Failure to Initialize Document while trying to view a PDF document from the OnDemand client.

**Possible causes**

This messages indicate that the client was not able to start the Adobe Acrobat PDF viewing software. When the full Acrobat Version 6 is installed on a system, the most common cause is an incorrect value for a particular key in the Windows Registry.

**Action**

With Notepad or a similar editor, create a .reg file with the following two lines:

```
[HKEY_CLASSES_ROOT\AcroExch.Document\DefaultIcon]
@="C:\Program Files\Adobe\Acrobat 6.0\Acrobat\Acrobat.exe,1"
```

If Adobe Version 6 is installed in a directory other than the path shown above, modify the two-line .reg file to reflect this. Save the .reg file and double-click it to merge this particular key or value into the Windows Registry. Restart the OnDemand client.

**Troubleshooting scenario 5: Fields with spaces in them failed to produce search results**

**Symptom**

You entered a value that contains spaces into a search criteria field and ran a search, but did not receive any search result.

**Possible causes**

It is possible that you used the *In* operator when constructing the search. The *In* operator uses a space as the delimiter to separate search requests. When you entered a value that contains a space, the *In* operator interprets it as two queries.

**Action**

Do not use values with spaces in them when using the *In* operator.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.
Trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

<table>
<thead>
<tr>
<th>IBM</th>
<th>Domino.Doc</th>
<th>OpenEdition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Function Presentation</td>
<td>DRDA</td>
<td>OS/2</td>
</tr>
<tr>
<td>Advanced Function Printing</td>
<td>EDMSuite</td>
<td>OS/390</td>
</tr>
<tr>
<td>AFP</td>
<td>Enterprise Storage Server</td>
<td>Parallel Sysplex</td>
</tr>
<tr>
<td>AIX</td>
<td>ES/390</td>
<td>OS/400</td>
</tr>
<tr>
<td>AIX/6000</td>
<td>eServer</td>
<td>Presentation Manager</td>
</tr>
<tr>
<td>AS/400</td>
<td>FlowMark</td>
<td>Print Services Facility</td>
</tr>
<tr>
<td>Bar Code Object Content Architecture</td>
<td>ImagePlus</td>
<td>pSeries</td>
</tr>
<tr>
<td>BCOCOA</td>
<td>Infoprint</td>
<td>RACF</td>
</tr>
<tr>
<td>BookManager</td>
<td>Intelligent Printer Data Stream</td>
<td>RS/6000</td>
</tr>
<tr>
<td>CICS</td>
<td>IPDS</td>
<td>S/390</td>
</tr>
<tr>
<td>Cryptolope</td>
<td>iSeries</td>
<td>SecureWay</td>
</tr>
<tr>
<td>DataJoiner</td>
<td>Language Environment</td>
<td>SET</td>
</tr>
<tr>
<td>DB2</td>
<td>Lotus</td>
<td>SP</td>
</tr>
<tr>
<td>DB2 Connect</td>
<td>Lotus Notes</td>
<td>System/370</td>
</tr>
<tr>
<td>DB2 Universal Database</td>
<td>Mixed Object Document Content Architecture</td>
<td>Tivoli</td>
</tr>
<tr>
<td>DFSMSdfp</td>
<td>MO:DCA</td>
<td>Ultrastar</td>
</tr>
<tr>
<td>DFSMSdss</td>
<td>MQSeries</td>
<td>VideoCharger</td>
</tr>
<tr>
<td>DFSMSHsm</td>
<td>MVS</td>
<td>VisualInfo</td>
</tr>
<tr>
<td>DFSMS/MVS</td>
<td>MVS/DFP</td>
<td>WebSphere</td>
</tr>
<tr>
<td>Domino</td>
<td>Notes</td>
<td>z/OS</td>
</tr>
</tbody>
</table>

Intel and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Portions of the OnDemand Windows client program contain licensed software from Pixel Translations Incorporated, © Pixel Translations Incorporated 1990, 2003. All rights reserved.

Other company, product or service names may be trademarks or service marks of others.
Glossary

A

administrator. In OnDemand, a person authorized to maintain the system. For example, an OnDemand administrator can add, update, and delete users and folders.

Advanced Function Presentation (AFP). A set of licensed programs that use the all-points-addressable concept to print data on a wide variety of printers or display data on a variety of display devices.

AFP. Advanced Function Presentation

annotations. Comments, clarifications, and reminders that can be attached to a document.

application. In OnDemand, an object that describes the physical attributes of a report or input file, such as the type of data found in the input file, the code page, and whether the input data contains carriage control characters. An application also contains instructions that the data indexing and loading programs use to process the input data. Most customers define an application for each different output print data stream or source of data that they plan to store in OnDemand.

C

client. (1) In a distributed file system environment, a system that is dependent on a server to provide it with programs or access to programs. (2) A workstation connected to a network running OnDemand software that can log on and query the library server, retrieve documents from OnDemand, and view and print documents.

copy group. In Tivoli Storage Manager, a policy object that contains attributes that control the generation, destination, and expiration of backup and archive files. There are two kinds of copy groups: backup and archive. Copy groups belong to management classes.

D

default. A value, attribute, or option that is assumed when no alternative is specified by the user.

default value. A predetermined value, attribute, or option that is assumed when no other is explicitly specified.

document. (1) In OnDemand, a logical section of a larger file, such as an individual invoice within a report of thousands of invoices. A document can also represent an indexed group of pages from a report. (2) A file containing an AFP data stream document. An AFP data stream document is bounded by Begin Document and End Document structured fields and can be created using a text formatter such as Document Composition Facility (DCF).

F

folder. A container for related information, such as statements, invoices, or correspondence, regardless of the source of the information or where the data is stored. When you open a folder, you have access to all of the information that it contains. For example, a billing folder might contain all of the reports for customer transactions over the past two years.

I

icon. A 32 by 32 pixel bitmap used by the windows manager to represent an application or other window.

L

LAN. local area network

line data. Data prepared for printing on a line printer, such as an IBM 3800 Model 1 Printing Subsystem. Line data is usually characterized by carriage-control characters and table reference characters.

line-data print file. A file that consists of line data, optionally supplemented by a limited set of structured fields.

local area network (LAN). (1) A computer network located on a user’s premises within a limited geographical area. Communication within a local area network is not subject to external regulations; however, communication across the LAN boundary might be subject to some form of regulation. (2) A network in which a set of devices is connected to one another for communication and that can be connected to a larger network. See also Token-Ring Network.

M

menu bar. The area at the top of a window that contains choices that give a user access to actions available in that window.
**N**

**named query.** A set of entry field values on the Search Criteria and Document List window that a user has named and saved for selection as search criteria at a future time.

**network.** A collection of data processing products that are connected by communication lines for information exchange between locations.

**notes.** Electronic comments, clarifications, and reminders that can be attached to an OnDemand document.

**P**

**point.** A unit of typesetting measure equal to 0.01384 inch (0.35054 mm), or about 1/72 of an inch. There are 12 points per pica.

**R**

**report.** A print data stream produced by a user-defined program or other software program that can contains hundreds or thousands of pages of related information. Most reports can be logically divided and indexed into single and multiple page objects called documents.

**S**

**server.** (1) On a network, the computer that contains the data or provides the facilities to be accessed by other computers on the network. (2) A program that handles protocol, queuing, routing, and other tasks necessary for data transfer between devices in a computer system. (3) A workstation connected to a TCP/IP network that runs the OnDemand programs that store, retrieve, and maintain report files. OnDemand supports two types of servers: a library server an object server.

**server printer.** A printer that is attached to a network server and is managed by a server print manager, such as IBM Infoprint Manager.

**string.** A series or set of alphabetic or numeric characters.

**T**

**toolbar.** The region directly beneath the menu bar of the main window in OnDemand client programs that support a graphical user interface. Click a toolbar button to quickly access a command.

**type.** To enter specific information using the keyboard, typing characters exactly as given.

**U**

**user.** A person authorized to log on to an OnDemand server.

**V**

**viewing window.** The window in OnDemand where you browse documents.

**W**

**wildcard character.** Search characters that represent other letters, numbers, or special characters. In OnDemand, the % (percentage) and the _ (underscore) are wildcard characters.
Index

A
adding a hard drive server 23
adding a network server 23
Adobe Acrobat 5
AFP
description 8
mapping in the Windows client 8
annotations
adding to documents 37
description 37
ATM 5
automated installation 8
automatically viewing a document 34
autoview 34
documents (continued)
viewing 33, 34, 36
E
exit from OnDemand 45
F
faxing
documents 38
selected documents 39
Find for next occurrence toolbar button 36, 37
Find for previous occurrence toolbar button 37
Find toolbar button 37
finding information in documents 37
folders
closing 45
opening 27
G
go to command 36
Go To toolbar button 36
H
hardware requirements 5
host name 21
I
installing
CD-ROM 7
distribution 8
multiple user 8
network 8
Windows client 7
L
logging on to a server 19
Logon to a Server window 19
M
moving to pages in a document 36
multiple user installation 8
N
navigating a document 36
network file server
description 8
installing client software on 8
network installation 8
notes
adding to documents 37
description 37
O
OnDemand
stopping 45
OnDemand client
removing 47
Open a Folder window 27
P
parameters
command line 15
startup 15
prerequisites
disk space requirements 5
hardware requirements 5
network requirements 5
recommended system 5
software requirements 5
Print toolbar button 38
printing
documents 38
selected documents 39
R
recommended preparation vi
requirements
disk space 7
disk space requirements 5
hardware 7
hardware requirements 5
network 7
network requirements 5
recommended system 5
software 7
software requirements 5
retrieve and display from document list
document properties 35
document viewing window 35
documents
annotations 37
closing 45
faxing 38
find command 37
go to command 36
moving to a page 36
notes commands 37
printing 38
searching for 29
selecting 33
sending
by e-mail 39
by MAPI 39
© Copyright IBM Corp. 1997, 2004

© Copyright IBM Corp. 1997, 2004
sending documents 40
sending documents 39
server
   CD-ROM as a 22
   changing information for existing 22
   deleting 24
   logging off from 45
server information
   updating 21
software requirements 5
starting OnDemand
   from the desktop 16
   from the Run command window 17
   from the Start menu 17
startup parameters 15
stopping document retrieval 34, 40

T

tasks
   logging on to a Server 19
   opening folders 27
   selecting and viewing documents 33
   starting from the desktop 16
   starting from the Run command window 17
   starting from the Start menu 17
   stopping OnDemand 45
TCP/IP servers, changing information 22
troubleshooting scenarios
   "Send To" function is disabled 51
   AFP plugin fails with a back level
   OnDemand client 51
   Documents in another language cannot be viewed 51
   errors while trying to view a PDF document 52
   failed to get search results 52

U

Update Servers window 21
updating
   client software 9
   server information 21
user-defined files
   description 8
   installing 8
using the CD-ROM as an OnDemand server 43

V

viewing document properties 40
viewing documents 36

W

wildcard characters 30
windows
   Logon to a Server 19
   Open a Folder 27

Windows client
   adding 49
   Adobe Acrobat 5
   ATM 5
   CD-ROM 7
   installing 7
   modifying 49
   removing 49
   updating 9
Program Number: 5655-H39
5724-J33
5722-R01